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1 PREFACE 

The Bruker Compass QuantAnalysis 2.0 application (referred to as ‘QuantAnalysis’) is 
the state-of-art Windows XP application for quantitation of analyses acquired on Bruker 
Daltonics mass spectrometer instruments. QuantAnalysis is specifically designed to 
process analyses acquired on the esquire/HCT ion trap, the micrOTOF ESI time-of-
flight and the APEX FTMS mass spectrometers. 

QuantAnalysis is an advanced program dedicated for quantitation of MS and MSn 
analyses. Dynamically linked views of the spreadsheet data, the chromatogram and 
spectrum, and the calibration curve make quantitation faster and easier. A change in 
any of the views, e.g., selecting a different curve fit for calibration, is immediately 
reflected in all other views. QuantAnalysis processes batches acquired with Bruker 
Compass HyStar or Agilent ChemStation. Printed reports in various layouts are avail-
able and custom layouts can be created using the Bruker Compass ReportDesigner. 

 
The QuantAnalysis Reference Manual describes the menus and commands avaible in 
QuantAnalysis 2.0. For reference on how to work with QuantAnalysis 2.0, please refer 
to the QuantAnalysis User Manual that is available as PDF document with your instal-
lation. 
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2 FILE MENU 

  
Figure 2-1 File menu 

The File menu offers the following commands:  
New  Creates a new batch file. 
Open  Opens the selected batch file. 
Save  Saves the open batch file under the same file name. 
Save As  Saves the open batch file under a new or an existing file name. 
Send To  Pops up the following commands: 

Mail Recipient  Prints a selected report to a PDF file and sends this to a specified 
email address. 

PDF Document Prints a selected report to a PDF file. 
Recent File  Opens the batch file corresponding to the file name selected. 
Exit  Closes QuantAnalysis. 
 

2.1 New Command 

The New command is used to create a new batch file. Using this command is only 
required when another batch file is already open.  
The command closes the currently open batch file and clears the Work Table. If the 
open batch file was changed but the new processing state has not been saved yet, a 
confirmation request to save the changed state appears first.  
 



File Menu Bruker Daltonik GmbH 

 QuantAnalysis Reference Manual, Version 2.0 2-2 

Shortcuts 

Button:   
Keys: CTRL+N 

 

2.2 Open Command 

The Open command is used to open an existing batch file. QuantAnalysis writes a 
new, additional result file on each saving operation you perform on a batch file. Thus, 
for each batch file one or several result files are available. If more than one result is 
available for the batch file you want to open you can select either any of its previously 
saved results or the last saved result to be loaded. Only one batch file can be open at a 
time. 
 
The command opens the Open Batch dialog, which allows you to specify the batch file 
you wish to open. The chosen batch file’s Result History is displayed, and if it contains 
more than one result, you can select which result you want to load. 

Look in and folder list 
Navigate to the drive and folder that contains the batch file you wish to open. Double-
click the batch file or select it and click Open. 

File name 
Enter the file name of the batch file or select a batch file from the folder list. 

Files of Type 
Select the type of files to be displayed in the folder list: 

Batch Files (*.btc). Lists *.btc files. 

(Result history) 
Lists all saved results of the batch file selected in the folder list with corresponding 
information about the date and time it was saved (Date), who saved it (Saved by) and 
if it was signed (Signed). 
From this list, you can load a previous saved result of the batch file by selecting the 
desired result. If no result is selected when clicking Open, the last saved result of the 
selected batch will be loaded. 
You can delete a result of a batch file and remove it from the Result history using the 
History button found in the Work Table window. 
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Figure 2-2 Open Batch dialog 

Open 
If a folder is selected, opens the folder, and displays its contents in the folder list.  
If a batch file is selected, opens the respective batch file in QuantAnalysis, and displays 
its contents in the Work Table, Chromatogram/Spectrum and Calibration windows. If for 
the selected batch file more than one result is available, the actually loaded data 
depends on the current selection in the batch file’s Result history. If a previous result is 
selected, this result is loaded; if no result is selected the last saved result is loaded. 
If another batch file is currently open and changes to it have not been saved yet, first a 
confirmation request to save the changed state is displayed. 
 
Shortcuts 

Buttons:     
Keys: CTRL+O 
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2.3 Save Command 

The Save command is used to save the open batch file under the same file name. This 
includes the current state of the batch file and the parameter settings of the quantitation 
method used. Each saving operation results in a new, additional result file being 
created for the respective batch file. Existing result files are not overwritten. 
The command saves the current state and the quantitation method parameter settings 
of the open batch file in a new result file. If the respective batch file has not been saved 
yet, the Save As dialog appears automatically to allow you to select a file name for this 
new batch file. 
 

Shortcuts 

Buttons:     
Keys: CTRL+S 

 

2.4 Save As Command 

The Save As command is used to save a batch file using a new or existing file name. 
When you save a batch file under a new name, a subfolder with the specified batch 
name is set up in the chosen target folder into which all results and later files corre-
sponding to the respective batch file will be saved. 
Note: The batch file must be saved to that folder that contains the data files to be 

quantified. 
 
The command opens the Save Batch dialog, which allows you to specify the file name 
for the new batch file and the target folder. 

Look in and the folder list 
Navigate to the drive and folder that contains the data files to be quantified.  

File name 
Enter a new batch file name or select an existing name from the folder list to overwrite 
an existing batch file. 

Files of Type 
Select the type of files to be displayed in the folder list: 

Batch Files (*.btc). Lists *.btc files. 
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Figure 2-3 Save Batch dialog 

Save 
If a new file name is entered, a subfolder with the specified batch file is created in the 
chosen target folder, and the corresponding result file is saved to that subfolder. 
If an already existing file name is selected, a confirmation request appears, informing 
you that a batch file of this name already exists. It asks you if you really wish to over-
write it. Clicking Yes results in the new file overwriting the existing result file; clicking 
No allows you to enter a new file name. 
 

2.5 Send To Popup Command 

Pointing to this submenu pops up the following commands for sending reports: Mail 
Recipient and PDF Document. 
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2.6 Send To > Mail Recipient 

The Mail Recipient command is used to print a selected to a PDF file and send this 
automatically as an attachment of an email to a specified email address. The report is 
saved with the name of the selected layout. 
The command opens the Send To Mail Recipient dialog, which allows you select the 
report to be created and the recipient to whom you want to send this report as email. If 
on selecting this command the current processing state of a selected analysis has not 
been saved yet, first a corresponding message appears that asks you about saving the 
respective analysis. Affirm this request, to save the analysis and open the Send To 
Mail Recipient dialog. 

 
Figure 2-4 Send To Mail Recipient dialog 

Email address 
Enter the email address of the recipient to whom you want to send the report. 
 
In Printer select the printer and print properties to be used: 
Name 
Displays the currently connected printer. If you wish to use another printer, select it 
from this list. 
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Properties 
Allows you to define page set up and further options for the selected printer. Opens the 
Properties of 'printer' dialog, which is printer specific. Select e.g. the printer orienta-
tion to print the report in Portrait or Landscape format. 

Status 
Displays the status of the selected printer. 

Type 
Displays the type of the selected printer. 

Where 
Localizes the selected printer. 

Comment 
Displays a comment, if available. 
 
In Report Layout, select the report layout you wish to print. Appropriate report layouts 
depending on the instrument used are listed automatically. 

Instrument 
Displays the instrument for which appropriate report layouts are listed in Layout.  
The instrument used for acquiring the selected analysis is selected by default. If you 
want to select a layout appropriate for another instrument category, uncheck Select 
automatically to enable this list box and select the desired category. This subsequent-
ly lists the corresponding layouts in Layout.  
The following categories are available: 

<all>. Lists all layouts available. 
<independent>. Lists instrument-independent layouts. 
Esquire. Lists Esquire layouts. 

Select automatically 
Check this option to list automatically report layouts appropriate for the instrument used 
for acquiring the selected analysis. This selects the respective instrument in Instru-
ment and lists corresponding layouts in Layout. Uncheck this option if you want to 
select a layout set up for another instrument. Default is checked. 
Layout 
Lists the report layouts appropriate for the category selected in Instrument. Select 
from this list the type of report you want to print.  

ReportDesigner 
Starts the Bruker Compass ReportDesigner application and loads the report layout 
selected in Layout. The ReportDesigner allows you to create your own report layouts. 
Note: If you want to create a new report layout, it is recommended not to modify the 

original layout but to save the modified layout under a new file name. Other-
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wise, there is a risk that your changed layout version becomes overwritten by a 
later system upgrade. 

Note: All QuantAnalysis report layouts must be saved to: 
"C:\BDALSystemData\Report Layouts\QuantAnalysis". 
Otherwise, QuantAnalysis will not list them in Layout. 

Send 
Opens the Choose Profile dialog (see below) to select the profile you want to use with 
Microsoft Exchange.  
 

Choose Profile dialog 
The Choose Profile dialog is used to select the profile to be used with Microsoft 
Exchange. In addition, this dialog allows you to set up a new profile and specify 
advanced options for logging on. 

 
Figure 2-5 Expanded Choose Profile dialog (after clicking Options) 

Profile Name 
Select the profile you want to use. 

New 
Allows you to create a new profile. Opens the Windows Messaging Setup Wizard. To 
create a new profile, follow the instructions of the wizard. 

Options 
Expands the dialog and displays the following advanced options for logging on. 

Set as default profile 
Sets the selected profile as the default. You can set some messaging applications, 
such as Microsoft Exchange, to log on automatically using your default profile. 

Show Logon screens for all information services 
Displays the logon dialogs for each information service in the selected profile. 
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OK 
Creates the selected report, saves it as PDF document, and sends it as email to the 
specified recipient. If no email address is specified, the email program will prompt for it. 
 

2.7 Send To > PDF Document 

The PDF Document command is used to print a selected report to a PDF file and save 
it to a chosen target folder. 
The command opens the Send To PDF Document dialog, which allows you to select 
the report to be created and to specify path and name for the PDF document to be 
saved. If on selecting this command the current processing state of a selected analysis 
has not been saved yet, first a corresponding message appears that asks you about 
saving the respective analysis. Affirm this request, to save the analysis and open the 
Send To PDF Document dialog. 

 
Figure 2-6 Send To PDF Document dialog 

PDF file name 
Enter path and name for the PDF document to be saved. The folder of the active ana-
lysis and the name ‘Report.pdf’ are suggested by default. If you want to save the PDF 
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document with another name, change the name as desired. If you want to save the 
document to another folder, either enter the respective path or click  and select the 
desired folder in the appearing dialog. 

Save 
Creates the selected report and saves it as PDF document with the specified name in 
the chosen target folder. 
 
For the other parameters, please refer to section 2.6. 
 

2.8 Recent File List 

You can use the numbers and batch file names listed in the recent file list at the bottom 
of the File menu to open quickly one of as many as ten previous closed files. Select the 
number that corresponds to the batch file you want to open. This loads the last saved 
result available for the batch file.When pointing on a recent file, corresponding full path 
name is displayed in a tool tip. 

 
Figure 2-7 Tool tip displaying full path name of selected recent file 
 

2.9 Exit Command 

The Exit command closed your current QuantAnalysis session. It automatically stores 
the current user interface settings for the current user logged into Windows. If changes 
made to the currently open batch file have not been saved yet when closing QuantAna-
lysis, a request appears asking you about saving the current state. After answering this 
request, QuantAnalysis is closed.  

Shortcuts 
Keys: ALT+F4 
Mouse: Click the application's Close  or double-click the application's Con-

trol menu button. 
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3 EDIT MENU 

  
Figure 3-1 Edit menu 

The Edit menu offers the following commands:  
Undo  (Not yet implemented.) 
Cut  Cuts the current selection and puts it on the Clipboard. 
Copy  Copies the selection and puts it on the Clipboard. 
Paste  Inserts the current Clipboard contents.  
 

3.1 Undo Command 

The Undo command is not yet implemented.  

Shortcut 
Keys: CTRL+Z 

 

3.2 Cut Command 

The Cut command cuts the current selection and puts it onto the Clipboard.  

Shortcuts 

Button:   
Keys: CTRL+X 
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3.3 Copy Command 

The Copy command copies the current selection and puts it onto the Clipboard.  

Shortcuts 

Button:   
Keys: CTRL+C 

 

3.4 Paste Command 

The Paste command pastes the current Clipboard contents to the selected position.  

Shortcuts 

Button:   
Keys: CTRL+V 
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4 VIEW MENU 

  
Figure 4-1 View menu 

The View menu offers the following commands: 

Toolbar  Shows/Hides the toolbar. 
Status Bar  Shows/Hides the status bar. 
 

4.1 Toolbar Command 

The Toolbar command shows/hides the toolbar. The toolbar is hidden by default. 
 

4.2 Status Bar Command 

The Status Bar command shows/hides the status bar. The status bar is shown by 
default. 
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5 METHOD MENU 

  
Figure 5-1 Method menu 

The Method menu offers the following commands:  
Open  Opens the selected quantitation method. 
Save As  Saves the open quantitation method under a new or an existing file name. 
Edit  Edits the open quantitation method. 
 

5.1 Open Command 

The Open command is used to open a quantitation method and attach it to the loaded 
batch file in place of the previously attached quantitation method. This overwrites the 
previous QuantAnalysis part of the method with the new one. You can view and proc-
ess the current parameter settings of the active method via the Edit command from the 
Method menu. 
In Compliance mode, methods can be saved as SOP or non-SOP methods (SOP = 
standard operating procedure) if the UserManagement administrator has turned on 
SOP method handling. All operators can load methods with an SOP flag but only 
operators with a special right can also load non-SOP methods. If the current operator 
does not have this right, the Open Method dialog shows SOP methods only. The 
SOP/non-SOP status of a selected method is indicated by the SOP method check box. 
If the UserManagement administrator has defined an SOP method folder, methods can 
be loaded only from that default folder except the operator has the special right to use 
non-default method folders, too. 
 
The command opens the Open Method dialog, which allows you to select the desired 
quantitation method. 

Look in and folder list 
Navigate to the drive and folder that contains the method you want to open. Double-
click the method or select it and click Open. 
If SOP method handling is turned on and you do not have the right to open non-SOP 
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methods, the folder list shows SOP methods only. If an SOP method folder has been 
defined and you do not have the right to use non-default method folders, you can load 
methods only from the default folder. 
 

  
Figure 5-2 Open Method dialog (when in Compliance mode with SOP method 

handling being enabled) 

Method name 
Enter the name of the desired method or select a method from the folder list. 
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Filter 
Select the type of methods to be displayed in the folder list: 

Methods with QuantAnalysis Part (*.ms, *.m). Filters methods containing a 
QuantAnalysis part. 

All (*.*). Lists all data files available. 

(Method part list) 
Lists under Method Part Type all application method parts currently contained in the 
selected method and under Method Part Name the corresponding part names. 

Comment 
Displays the comment for the selected method if available. A comment can be entered 
when the method is saved using the Save As command from the Method menu. A 
comment applies to the entire method. 

SOP method 
Note: This option is available when SOP method handling is activated. 
Indicates the SOP/non-SOP status of the selected method. 

Open 
Opens the selected quantitation method and attaches it to the loaded batch file.  
If SOP method handling is turned on and you have selected another folder than the 
default SOP method folder but do not have the corresponding right a corresponding 
message will appear. 

Shortcut 

Button:   
 

5.2 Save As Command 

The Save As command is used to save the quantitation method as 'QuantAnalysis 
part' either into an existing method with replacing the current QuantAnalysis part or into 
a new method. The latter creates a new method with only the QuantAnalysis part being 
contained whereas saving into an existing method results in modifying the selected 
original method. Each method can contain only one QuantAnalysis part. 
In Compliance mode, methods can be saved as SOP or non-SOP methods (SOP = 
standard operating procedure) if the UserManagement administrator has turned on 
SOP method handling. Methods with an SOP flag cannot be modified. Only operators 
who have the special right can mark SOP methods. If the UserManagement admini-
strator has defined an SOP method folder for saving/loading SOP methods operators 
need a special right to use non-default method folders, too. 
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The command opens the Save QuantAnalysis Method Part As dialog, which allows 
you to select the file name and target folder in which the method should be stored. 
 

  
Figure 5-3 Save QuantAnalysis Method Part As dialog (when in Compliance mode 

with SOP method handling being enabled and the operator has the right to 
mark methods as SOP) 

Save in and folder list 
Navigate to the drive and folder in which you want to save the method. Navigate to the 
drive and folder in which you want to save the method. If SOP method handling is 
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turned on and an SOP method folder has been defined, you have to save the method 
in the default folder if operators without the right to use non-default method folders 
should use the method. To save the method to another folder you need the corre-
sponding right. 

Method name 
Enter the name of the method into which the QuantAnalysis part should be saved. If 
you want to overwrite an existing method, enter its name or select it from the folder list. 
If you wish to create a new method, enter the desired new name. 

Filter 
Select the type of methods to be displayed in the folder list: 

Methods with QuantAnalysis Part (*.ms, *.m). Lists methods containing a Quant-
Analysis part. 

All (*.*). Lists all data files available. 

Method part name 
Enter the name the QuantAnalysis part should be saved with in the specified method. A 
part name can be entered in a sense of a comment. If no name is entered, the Quant-
Analysis part will get a part name that is the same as the method name. 

(Method part list) 
Lists under Method Part Type all application method parts currently contained in the 
specified method and under Method Part Name the corresponding part names. 

Comment 
Optionally enter a comment for the method. A comment applies to the entire method. 

Method is SOP 
Note: This option is available when SOP method handling is turned on. It is enabled 

when the operator has the right to mark a method as SOP. 
Check this option if you want to mark the method as SOP. This sets the SOP flag, 
which allows loading the method by all operators. If the flag is not set only operators 
with the right to load non-SOP methods can load the method. Default is not checked. 

Save 
Depending on whether a new or an existing method name is chosen, the current para-
meter settings of the QuantAnalysis part are saved into a new or an existing method 
file together with the specified part name and comment, if available. If the QuantAnaly-
sis part should be saved into an existing method, the previous QuantAnalysis part of 
this method becomes overwritten after you have confirmed the corresponding request. 
If the QuantAnalysis part should be saved into a new method, the new method is 
created that contains only the QuantAnalysis method part. 
The specified new (or modified) method is automatically attached to the loaded batch 
file. 
If SOP method handling is turned on with an SOP method folder being defined and you 



Method Menu Bruker Daltonik GmbH 

 QuantAnalysis Reference Manual, Version 2.0 5-6 

do not have the right to use non-default method folders, a message will appear if the 
default folder is not selected. 
 

5.3 Edit Command 

The Edit command is used to edit the parameter settings for the quantitation procedure 
you wish to use. Selecting this command starts the Method Editor and guides you 
through the set up of a method. The Method Editor's General dialog appears automa-
tically. 

Shortcut 

Buttons:     
 

5.3.1 Edit Command - General 

The General dialog is used to define the default injection volume used, an accuracy 
limit, if the dilution factor should be applied to ISTD compounds, too, and whether mass 
spectra should be recalculated when loading an analysis. 

Default Injection Volume 
Enter the default injection volume used during data acquisition. 

Accuracy limit (%) 
Enter a limit value for the Accuracy parameter that is calculated for 'Calib' and 'QC' 
samples. All calculated accuracy values that exceed this defined limit will be displayed 
in the Work Table in red color. This allows quick assessment of those integrations 
where problems may have occurred and which should be checked whether a manual 
reintegration is necessary. Default is 20. 

Apply dilution factor to ISTD compounds 
Check this option to apply the dilution factor set in the Work Table's Dil. Factor column 
also to ISTD compounds. If this option is not checked, the dilution factor will be applied 
to the target compounds only. 

Load calibration from DataAnalysis results 
Check this option if the mass spectra in an analysis being loaded in QuantAnalysis 
should be calibrated using the calibration coefficients stored in the last DataAnalysis 
result of the respective analysis. 

Next 
Switches forward to the method editor's Chromatograms dialog. 
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Figure 5-4 Method Editor's General dialog 

 

5.3.2 Edit Command - Chromatograms 

The Chromatograms dialog is used to define the chromatogram traces for the com-
pounds to be quantified and for the internal standards used. The traces are defined in 
the same way as in DataAnalysis.  

Note: To define the chromatogram traces you have to know the MS details of the ana-
lysis.  

In the example shown in the dialog below, a target analysis was performed. The target 
compound Alprazolam and its d5-derivative, used as internal standard, both form 
[M+H]+ compound ions (m/z = 309 and 314) which give two specific fragment ions in 
MS/MS experiments (m/z 309 → m/z 274 and 281; m/z 314 → m/z 279 and 286). 
During the chromatographic run alternating MS/MS experiments for both compounds 
were performed. The fragments were scanned and used for quantitative analysis. For 
quantitation, you have to define the chromatogram traces for the target compound and 
for the internal standard. 
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Figure 5-5 Method Editor's Chromatograms dialog showing parameter settings for an 

already defined chromatogram trace 

Traces 
Lists all chromatogram traces currently defined. Each chromatogram trace is repre-
sented by a short description and a color box that indicates the color the respective 
chromatogram is displayed with in the Chromatogram view of the Chromatogram/ 
Spectrum window after quantitation has been performed. For changing or deleting an 
already defined chromatogram trace, select it from this list. 

Type 
Select the type of chromatogram trace to be edited.  

Total Ion Chromatogram. (Default) This calculates a chromatogram by summing 
up the intensities of all masses contained in the mass spectra of the selected 
MS/MS type. Abbreviation is 'TIC'. 

Extracted Ion Chromatogram. This calculates a chromatogram by summing up the 
intensities of the specified mass(es) contained in the mass spectra of the selec-
ted MS/MS type. Abbreviation is 'EIC'. 

Base Peak Chromatogram. This calculates a chromatogram by using the intensity 
of the most abundant of the specified masses contained in the mass spectra of 
the selected MS/MS type. Abbreviation is 'BPC'.  

Depending on the selected type, specific options for defining the chromatogram trace 
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are displayed below this list box. 

Filter 
Select the type of mass spectra to be filtered for calculating the respective chromato-
gram trace. 

All (MS and MSn). (Default) Uses all mass spectra (no filter). 
All MS. Uses all MS spectra. 
All MSn. Uses all MSn spectra. 
MSn. Uses only MSn spectra of the precursor ion specified in of. 

of 
For MSn filter chosen, select the precursor ion mass to be used for calculating the 
chromatogram trace. The list includes all isolated and fragmented masses, which have 
been collected during data acquisition. 

Masses 
For an Extracted Ion Chromatogram or Base Peak Chromatogram enter the mass 
values or mass ranges to be used for calculating the respective chromatogram trace. 
Default is full mass range.  
Single masses: Separate each mass value by a comma, semicolon or plus sign.  
Mass ranges: Separate starting and ending masses by a hyphen "-". Leaving starting 

(or ending) mass empty results in the first (or last) measured mass of the chroma-
tographic run to be chosen. Entering only a hyphen selects the full mass range. 

Note: Exclusion masses are not included in the respective calculation. 

Width 
For an Extracted Ion Chromatogram or Base Peak Chromatogram, select a mass 
precision range from the list of pre-defined precision ranges or enter a customized 
range. The precision range to be used depends on how precise the respective meas-
urement was. Normally it is not necessary to change the default value but in the case 
of mass shifts during analysis, this width can be adjusted. Default is ±0.5. 

Polarity 
For an Extracted Ion Chromatogram or Base Peak Chromatogram, select the pola-
rity of the ions to be used for calculating the respective chromatogram trace. If the 
chromatogram traces were acquired in alternating mode, i.e. alternating scans in posi-
tive and negative ionization mode were performed, you have to select the right polarity 
for trace definition: 

both (±). (Default) Uses both positive and negative ions. 
positive (+). Uses positive ions only. 
negative (−). Uses negative ions only. 

Color 
Select the color the selected chromatogram trace should be displayed with. 
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Smth Width (Gauss[sec]) 
If you want to smooth the chromatogram trace because it is very noisy, enter an appro-
priate smoothing width (in seconds). An entry of '0' will result in no smoothing. Default 
is '0'. 

Cycles 
Enter the number of smoothing cycles to run. Default is '1'. 

Add 
Adds the new defined chromatogram trace to Traces. 

Change 
Changes the chromatogram trace selected in Traces according to the new settings. 

Delete 
Deletes the selected chromatogram trace from Traces. 

Next 
Switches forward to the Method Editor's ISTD Compounds dialog. 

Back 
Switches back to the Method Editor's General dialog. 
 

5.3.3 Edit Command - ISTD Compounds 

The ISTD Compounds dialog is used to define the internal standard compound(s) 
used. For each ISTD compound, you have to enter its name and the corresponding 
chromatographic and concentration data.  
Note: In the case of a quantitation with external calibration, you can skip this dialog 

and proceed with the Target Compounds dialog. 
ISTD Compounds 
Lists all ISTD compounds currently defined. For changing or deleting an already 
defined ISTD compound, select the respective ISTD compound from this list. 

Name 
Enter the name of the ISTD compound. 

CAS No. 
Enter the CAS number of the ISTD compound (optional).  

Chrom. 
Select the chromatogram trace that corresponds to the ISTD compound. 
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Figure 5-6 Method Editor's ISTD Compounds dialog showing parameter settings for 

an already defined ISTD compound 

Retention time [min] 
Enter the retention time (in minutes) of the ISTD compound peak. 

Window [min] 
Enter the width of the time window (in minutes) for the software to search for the ISTD 
compound peak.  

Default Concentration 
Enter the default concentration of the ISTD compound. 

Concentration units 
Enter the concentration units of the default concentration. 

Add 
Adds the new defined ISTD compound to ISTD Compounds. 

Change 
Changes the ISTD compound selected in ISTD Compounds according to the new 
settings. 
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Delete 
Deletes the ISTD compound selected in ISTD Compounds. 

Next 
Switches forward to the Method Editor's Target Compounds dialog. 

Back 
Switches back to the Method Editor's Chromatograms dialog. 
 

5.3.4 Edit Command - Target Compounds 

The Target Compounds dialog is used to define the target compounds to be used in 
quantitation and their standard concentrations.  
 

 
Figure 5-7 Method Editor's Target Compounds dialog showing parameter settings for 

an already defined target compound 

Target Compounds 
Lists all target compounds currently defined. For changing or deleting an already 
defined target compound, select the respective compound from this list. 
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Name 
Enter the name of the target compound.  

CAS No. 
Enter the CAS number of the target compound (optional). 

Chrom. 
Select the chromatogram trace that corresponds to the target compound.  

ISTD 
Select the ISTD compound that should be assigned to the target compound. 

Retention time [min] 
Enter the retention time (in minutes) for the target compound peak. 

Window [min] 
Enter the width of the time window (in minutes) for the software to search for the target 
compound peak. 

Concentration units 
Enter the concentration units for the standard concentrations of the target compound. 

Standard conc. 
Define the standard concentrations for the calibration levels given in the Work Table's 
Calib Level column. For this, level ID and corresponding concentration value pairs 
must be entered. 
- To enter a new calibration level/concentration pair, click . Then enter the level ID 

and concentration value separated by a semicolon (;) and click on the list box or 
press the Enter key. This adds the new pair at the bottom of the list.  

- To delete a calibration level/concentration pair, select it and click . 
- To move a calibration level/concentration pair to another position in the list, click  

or  until the desired position is reached. 

Add 
Adds the new defined target compound to Target Compounds. 

Change 
Changes the target compound selected in Target Compounds according to the new 
settings. 

Delete 
Deletes the target compound selected in Target Compounds. 

Next 
Switches forward to the Method Editor's Integration Parameters dialog. 
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Back 
Switches back to the Method Editor's Target Compounds dialog. 
 

5.3.5 Edit Command - Integration Parameters 

The Integration Parameters dialog is used to define the parameter settings to be used 
for peak detection and mass spectrum calculation. Normally the default values allow 
good integration results but if necessary, the parameters can be given independently 
for each individual chromatogram.  
 

  
Figure 5-8 Method Editor's Integration Parameters dialog 

Chromatogram 
Select the chromatogram trace you will define for the peak detection and mass spec-
trum calculation parameters. 

used by 
Displays the target or ISTD compound the selected chromatogram trace is assigned to.  
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In Peak detection, define the parameters for peak detection: 
S/N threshold 
Enter the S/N (signal-to-noise) threshold a signal must exceed to be used in peak 
detection. Values from 0.001 to 1000 are allowed. Default is '1'. 
The S/N is defined as the height of the mass peak above its baseline, relative to the 
noise. The noise level is defined as 5 x sigma (sigma = standard deviation) and is 
calculated on the full mass spectrum except the regions of peaks.  
The steps included in the signal-to-noise ratio determination depend on the selected 
chromatographic peak finder version, Version 1.0 or Version 2.0. 
For Version 1.0: The S/N determination includes the following steps: 

1. The third derivative of the chromatogram is calculated using the Savitsky Golay 
algorithm with a smoothing width m as set. 
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4. The standard deviation is corrected with the smoothing width giving the noise σ for 
signal-to-noise ratio calculation: 

 3' m⋅= σσ , with m = smoothing width 
5. The signal-to-noise ratio S/N of each peak is then calculated as: 

 σ5/SS/N = , with S = peak height above the peak baseline. 
The noise N is determined as 5σ; statistically 99% of the noise values are within 
this range. 
The following drawing illustrates the Signal and the Noise values. 
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Figure 5-9 Illustration of the Signal and the Noise values 

For Version 2.0: The S/N determination is done in the following way: 
1. Determination of local maxima. 
2. Splitting of spectrum in segments according to number of local maxima. 
3. Per segment: 

a. Sorting of intensity values of local maxima (histogram). 
b. Calculation of first derivative using the Savitsky Golay algorithm with a smooth-

ing width of 1/10 of the number of local maxima in the segment (formula see 
above). 

c. Determination of points of minimal and maximal derivative of the histogram, 
which give the turning points of the distribution. 

d. Use the noise obtained from the intersection of the tangents at the appropriately 
selected turning points. 

Area threshold 
Define the area threshold a signal must exceed to be detected as a peak. Select the 
threshold type and enter the desired threshold value: 

Absolute. Uses an absolute threshold value. 
Relative. (Default) Uses a threshold value relative to the 100% (base) peak. 
(Area Threshold). Enter the relative or absolute area threshold value. Default is 

'0.1'.  

Intensity threshold 
Define the intensity threshold a signal must exceed to be detected as a peak. Select 
the threshold type and enter the desired threshold value. 

Absolute. Uses an absolute threshold value. 
Relative. (Default) Uses a threshold value relative to the 100% (base) peak. 
(Intensity Threshold). Enter the relative or absolute intensity threshold value. 

Default is '0.1'.  
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Skim ratio 
Enter the skim ratio to influence the calculation of peak areas of overlapping peaks. 
Default is '0.1'. 

Smoothing width 
Enter the number of mass spectra to be used for smoothing. Values from 1 to 20 are 
allowed. Default is '1'. 
 
In Mass spectrum calculation, define how the mass spectrum corresponding to a 
detected peak should be calculated: 

Width 
Select which mass spectrum/spectra should be included in calculating the resulting 
mass spectrum for a detected peak: 

Use actual peak width. (Default). Calculates the mass spectrum by averaging all 
mass spectra contained in the actual peak width.  

No. of average spectra. Calculates the mass spectrum by averaging a specified 
number of mass spectra. Enter the desired number of mass spectra in the related 
text box. Default is '5'. 

Apex. Calculates the mass spectrum using the Apex algorithm, taking the mass 
spectrum at the peak apex. 

None. Calculates no mass spectrum. 
 
Finish 
Finishes the Method Editor. 

Back 
Switches back to the Method Editor's Target Compounds dialog. 
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6 COMPASS MENU 

  
Figure 6-1 Compass menu 

The Compass menu offers the following command: 

Compass Desktop  Launches Compass Desktop. 
 

6.1 Compass Desktop Command 

The Compass Desktop command launches Compass Desktop which allows switching 
to other Bruker Compass applications. The buttons enabled depend on the programs 
currently installed on your computer.  
 

  
Figure 6-2 Compass Desktop 

Shortcut 
Button:   

 
 
 



Compass Menu Bruker Daltonik GmbH 

 QuantAnalysis Reference Manual, Version 2.0 6-2 
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7 HELP MENU 

  
Figure 7-1 Help menu (when in Compliance mode) 

The Help menu offers the following commands: 

Help Topics  Launches QuantAnalysis help. 
License  Registers your Bruker Daltonics applications licen-

ses. 
Operator  Logs in the specified operator. 
Lock All Applications Locks all Bruker Daltonics applications. 
About Compass QuantAnalysis  Provides information about your current QuantAna-

lysis copy. 
 

7.1 Help Topics Command 

The Help Topics command is used to start the QuantAnalysis help program in order to 
get information about specific topics. QuantAnalysis help operates as a standard Win-
dows help program. 

Shortcut 

Button:   
Key: F1 
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7.2 License Command 

The License command is used to view, add and/or delete licenses for Bruker Daltonics 
applications. The command opens the Bruker Daltonics LicenseManager dialog that 
shows any license currently available for any of the Bruker Daltonics applications and 
how long it will be valid. 
To add a new license, enter the license key you received in New license key and click 
Add. A new line is added to Existing licenses with the key you have entered, the pro-
duct name and the date until the license will be valid. To delete an existing license 
select it in Existing licenses, click Delete and confirm the corresponding request. 

Note: If QuantAnalysis is running in Compliance mode, only operators who have the 
special right can add or delete licenses. 

  
Figure 7-2 Bruker Daltonics LicenseManager dialog with 'ESI Compass 1.3' license 

needed for QuantAnalysis being present (example) 

New license key 
Enter the submitted license key. 

Existing licenses 
Lists already existing licenses. 

License key 
Lists the license keys for the existing licenses. 
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Valid until 
Permanent licenses are indicated as ‘unlimited’.  
For temporary licenses, the date until the respective license is valid is shown. An expi-
ration warning will inform you automatically about the forthcoming expiration of a tem-
porary license firstly 30 days before the respective expiration will expire. If for one 
product more than one license is present, this warning concerns to the longest valid 
license. An expiration warning will appear once per 24 hours and can be skipped by the 
operator. 

Product name 
Lists the names of the products for which licenses already exist. 

Add 
When in Non-Compliance mode, it licenses the product and adds the license key you 
entered in New license key to the list of existing licenses.   
When in Compliance mode, it opens the Re-enter Your Password dialog (see below) 
to re-enter the password for the current operator account. The license key is added 
after re-entering the correct password and if the operator has the required right. 
This button is enabled after the license key has been entered completely. 

Delete 
When in Non-Compliance mode, it deletes the license key selected in the Existing 
licenses list after affirming corresponding confirmation request.  
When in Compliance mode, it opens, after affirming confirmation request, the Re-enter 
Your Password dialog to to re-enter the password for the current operator account. 
The license key is deleted after re-entering the correct password and if the operator 
has the required right. 
 
Re-enter Your Password dialog 
This dialog is used to re-enter the password for the current operator account.  

 
Figure 7-3 Re-enter Your Password dialog 

Password 
Enter the password for the current operator account. 
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OK 
If the password is correct for the current operator account and the operator has the 
right to add/delete licenses the entered license key is added to or the selected license 
key is deleted from the LicenseManager’s Existing licenses list.  
If the password is incorrect or the operator does not have the required right a corre-
sponding error message will inform you.  
 

7.3 Operator Command 

The Operator command is used to change the operator during a QuantAnalysis ses-
sion. When QuantAnalysis is running in Compliance mode, you can also use this com-
mand to change your current password.  

Note: There can only be one operator at a time logged into Bruker Daltonics applica-
tions on a specific computer. 

 
The command opens the QuantAnalysis dialog, which allows you to log in or change 
your password. Depending on the current mode, Non-Compliance or Compliance, this 
dialog may appear different. In Non-Compliance mode, you can log in without 
identifying yourself, while in Compliance mode you must identify yourself by operator 
ID and password. 
Note: This dialog appears automatically whenever you start-up of your QuantAnalysis 

application unless you are currently logged in another Bruker Daltonics applica-
tion (for both Non-Compliance and Compliance mode) or the corresponding 
option for skipping this dialog is set (for Non-Compliance mode only).  

Operator 
Enter your operator ID. The ID of the current operator will automatically be entered if 
the UserManagement administrator has set the corresponding option. The operator ID 
is not case-sensitive. 

Password 
Enter your password. The password is not displayed as you type it. 
Note: Passwords are case-sensitive. The operator will be locked if the number of 

wrong login tries exceeds a number set by the UserManagement administrator. 
Only the UserManagement administrator can unlock a locked operator. 

Note: This entry field is available in Compliance mode only. 
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Figure 7-4 QuantAnalysis dialog for logging in the operator in Non-Compliance mode 

  
Figure 7-5 QuantAnalysis dialog for logging in the operator in Compliance mode 

Always login using this Operator 
Check this option to have the operator named in Operator logged in automatically. 
This will skip this dialog when starting QuantAnalysis in future. 
Note: This check box is available in Non-Compliance mode only. 

Change Password 
Allows you to change your current password before logging in. Opens the Change 
Password dialog. 
Note: This button is available in Compliance mode only. 

Log On 
Logs in the (specified) operator.  
In Compliance mode, log in will be successful only if operator ID and password match. 
If both do not match an error message will appear. Successive wrong password inputs 
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can cause locking of an operator by UserManagement. If a new created operator tries 
to log into a Bruker Daltonics application for the first time, the program requires for 
changing the password. Quitting the request opens the Change Password dialog. 
 
Change Password dialog 
The Change Password dialog is used to change the current password for the operator 
named in Operator. The new password must comply with the password policy settings 
defined by the UserManagement administrator. 

 
Figure 7-6 Change Password dialog 

Operator 
Displays the ID of the operator whose password can be changed. If the password for 
another operator should be changed, click Cancel and enter the desired operator in the 
previous dialog. 

Old password 
Enter your current password. The password is not displayed as you type it. 
Note: Passwords are case-sensitive. 

New password 
Enter the new password. The password is not displayed as you type it. 
Note: Passwords are case-sensitive. Make sure, that the new password complies with 

the current password policy settings. 

Confirm new password 
Confirm your new password. You must enter the same password as above. 

OK 
If the new password and its repetition are the same, and the new password complies 
with the password policy settings, it changes the password. A dialog appears informing 
you that your password was changed successfully. Quitting this dialog returns you to 
the QuantAnalysis dialog.  
If the new password and its repetition are different or the chosen password does not 
comply with the password policy settings, a corresponding message appears. Repeat 
the respective entries. 
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If the old password is incorrect, a message appears nforming you that the password 
was not changed. Quitting this message returns you to the QuantAnalysis dialog. 

   
Figure 7-7 Messages on successful password change (left) and chosen password is 

violating password policy (right) 
 

7.4 Lock All Applications Command 

Note: The Lock All Applications command is available only in Compliance mode. 

The Lock All Applications command is used to lock all Bruker Daltonics applications. 
This includes QuantAnalysis as well as all other Bruker Daltonics applications currently 
installed on your system.  
Note: Only the previous operator or someone with the special right to unlock applica-

tions can unlock a locked application.  
Note: All UserManagement-using Bruker Daltonics applications will be locked automa-

tically if one of these applications has not been used for a certain period as 
defined by the UserManagement administrator. 

 
The command opens the QuantAnalysis dialog which informs you that QuantAnalysis 
has been locked, by whom (displays full name of operator) and how it can be unlocked. 
You must enter the required entries to unlock the application. 

Operator 
Enter the operator ID of the operator who has locked QuantAnalysis. The respective 
operator ID will automatically be entered if the UserManagement administrator has set 
the corresponding option. 
If an operator other than the previous one wants to unlock the applications, enter the 
other operator ID.  
Note: This respective operator must have the right to unlock applications. 
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Figure 7-8 QuantAnalysis dialog when QuantAnalysis has been locked 

Password 
Enter the corresponding password. 
Note: Passwords are case-sensitive. The operator will be locked if the number of 

wrong login tries exceeds a number set by the UserManagement administrator. 
Only the UserManagement administrator can unlock a locked operator. 

Change Password 
Allows you to change your current password before logging in. Opens the Change 
Password dialog. 

Log On 
If operator ID and password match, and the respective operator is allowed to unlock 
applications, it unlocks Bruker Daltonics applications and logs in the specified operator. 
 

Shortcuts 

Button:   
Key: Ctrl+Alt+K 
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7.5 About Compass QuantAnalysis Command 

The About Compass QuantAnalysis command is used to display the version number 
of your current copy of DataAnalysis and QuantAnalysis with the copyright notice, the 
user-specific license information as well as the information on how to contact Bruker 
Daltonik GmbH. The command opens the About Bruker Daltonics QuantAnalysis 
dialog. 
 

  
Figure 7-9 About Bruker Daltonics QuantAnalysis dialog 

Shortcut 

Button:   
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8 COMMANDS ACCESSIBLE FROM 
BUTTONS ONLY 

In addition to the commands accessible from the menus, QuantAnalysis provides other 
commands that are accessible from buttons only. These commands can be found in 
the Work Table window and Chromatogram/Spectrum window. For example, process-
ing of a batch is performed by clicking the Process button in the Work Table window, 
or to print a specific quantitation report use the Report button in the Work Table win-
dow. 
 

8.1 Process Command (Work Table Window) 

The Process command is used to process the open batch file according to the current 
parameter settings defined in the selected quantitation method, and to save the quan-
titation results and the method used with the processed batch file. The batch file to be 
processed can be either a not-yet-processed or an already-processed batch file. 

Before processing a batch file, the quantitation method to be used must be opened or 
created. 

Clicking  in the Work Table window starts batch processing. First, the batch 
file is automatically saved. In the case of a not-yet-processed batch file, the Save As 
dialog will appear to allow you to save the processed batch file under a new file name 
and to keep the original batch file unprocessed for performing further processing 
operations on it, such as by using another quantitation method. In the case of an 
already-processed batch file no saving dialog will appear. After saving has occurred, 
the processing operation really starts. Usually, processing a batch file takes only a few 
seconds. A blue bar at the bottom of the screen shows the progress of this process. 

After processing is finished you should save the processed batch file. Then you can 
review the quantitation results obtained. 
 

8.2 Report Command (Work Table Window) 

The Report command is used to print a QuantAnalysis report containing specific quan-
titation data from the open batch file. All layouts can be printed in portrait and land-
scape format. You can preview the report before printing it. 

Note: With older printer models (with insufficient firmware performance), there might 
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be the problem that printing of a report takes a very long time. To overcome 
this, a registry switch now supports faster printing on such printers (see below)j. 

Clicking  in the Work Table window opens the Print dialog, which allows 
you to select the report layout you want to print and to specify the destination printer, 
other printer setup options and the number of copies. 
 

  
Figure 8-1 Print dialog 

For description of parameters, please refer to section 2.6. 

Preview 
Allows you to preview the selected report before printing it. It creates the report and 
shows in the Preview window how the report will look if you print it.  
If you want to print the report, you can start printing directly from the preview by clicking 

its . Otherwise, click the preview’s  to close it and return to the Print dialog. 

OK 
Creates the selected report and prints it on the specified printer.  
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Support for printing on older printer models 
With older printer models, there might be the problem that printing of a report takes a 
very long time since the firmware is too slow when converting the vector graphic into a 
bitmap graphic. To overcome this problem a registry switch is now available which lets 
DataAnalysis create the bitmap already and thus speeds up printing on such printers. 
Note: NT administrator privileges are required for setting the registry key. 

1. Click . 
2. Click Run. This opens the Run dialog. 
3. In Open, type in "regedit" and click OK. This opens the Registry Editor. 
4. Navigate to "Computer\HKEY_LOCAL_MACHINE\SOFTWARE\Bruker Daltonik".  
5. Right-click the key "Bruker Daltonik" and from the context-sensitive menu (CSM) 

select New > Key. Overwrite the default key name with "Printer". 
6. Right-click the key "Printer" and from the CSM select New > Key. Overwrite the 

default key name with the name of the printer for which you want to set the registry 
key, e.g. "HP LaserJet 5000 Series PCL". You must type in the name the respec-
tive printer is referred with in the DataAnalysis Print dialog. 

7. Right-click the key "[printer name]" and from the CSM select New > DWORD 
Value. This enters a double word (dword) value for the key "[printer name]" which 
is specified by the Name "New Value #1", the Type "REG_DWORD" and the Data 
"0x00000000 (0)". Overwrite the default name with "UseBitmaps". 

8. Right-click the name "UseBitmaps" and from the CSM select Modify. In the Edit 
DWORD Value dialog change the current Value data value from "0" to "1" and 
click OK. This changes the "UseBitmaps" value accordingly and thus switches the 
key on. 

9. Close the Registry Editor. 

  
Figure 8-2 Example registry key for faster printing on the named printer 
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8.3 History Command (Work Table window) 

The History command is used to show the result history of the open batch file and to 
load or delete a certain result of it. When QuantAnalysis is running in Compliance 
mode, it is also possible to sign a certain result.  

Clicking  in the Work Table window opens the Result History dialog. 
Depending on whether QuantAnalysis is running in Compliance or Non-Compliance 
mode, the dialog displays different information and allows for different operations. 
Generally, all results currently available for the open batch file are listed along with 
corresponding information about saving date and time, operator who saved as well as 
whether or not a result was deleted. When in Compliance mode, also information on 
already signed results is displayed. 

(Result history list) 
Lists all results saved since batch file setup, which also includes already deleted 
results. An arrow in front indicates the currently loaded result. Following information is 
given: 

No 
Running number of result referring to the chronology of saving. 

Date 
Date and time a result was saved. 

Saved by  
Operator who saved a result. 

Signed 
Shows whether a result is signed. Signing is indicated by a ‘yes’; otherwise no entry is 
present. Additional information about signing a result is displayed after selecting the 
respective result. 
Note: The Signed column is only available when QuantAnalysis is running in Compli-

ance mode. 

Deleted 
Shows whether a result was deleted. Deletion is indicated by a ‘yes’; otherwise no 
entry is present. Additional information about deleting a result is displayed after select-
ing the respective result. 
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Figure 8-3 Result History dialog for a batch file when in Non-Compliance mode 

 
Figure 8-4 Result History dialog for a batch file when in Compliance mode 
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When a result is selected in the result history list, additional information is displayed 
below the list concerning the following parameters: 

Saved by 
Operator who saved the result. 

Date 
Date and time the result was saved. 

Program version 
Program version used for saving the result. 

Deleted by 
Operator who deleted the result. 
 
In the Signature table, information about signing the selected result is shown. 
Note: The Signature table is only available when QuantAnalysis is running in Com-

pliance mode. 

Signer 
Lists the operator(s) who signed the selected result. 

Date 
Date and time the selected result was signed by the named signer. 

Meaning 
Meaning of signing the selected result by the named signer. 

Validity 
Result of signature check for the named signer. 

Load 
Loads the selected result of the open batch file. If changes made to the currently 
loaded result have not been saved yet, first a confirmation request on saving changed 
state will appear which you have to answer. 

Delete 
Deletes the selected result from the open batch file after you have affirmed the corre-
sponding confirmation request. Deletion is indicated by a ‘yes’ being entered for this 
result under Deleted. 
Note: When QuantAnalysis is running in Compliance mode, only operators who have 

the respective right can perform deleting a result. 

Sign 
Allows you to sign the selected result of the open batch file. Opens the Sign Electro-
nic Record dialog (see below). 
Note: The Sign button is available only in Compliance mode. 
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Note: Only operators who have the right to sign electronic records can sign a result. If 
the currently logged in operator does not have this right, an operator having this 
right can sign immediately. There is no need to change the logged in operator 
previously. 

 
Sign Electronic Record dialog 
The Sign Electronic Record dialog is used to sign electronically the electronic record 
(= result of a batch with corresponding method) that corresponds to the result currently 
selected in the Result History dialog. An electronic signature consists of operator ID 
and password. Optionally, the meaning of signing can be given. Multiple signing of 
results is allowed. 

Note: Signing electronic records is possible only in Compliance mode. 
Note: Only operators who have the right to sign electronic records can sign a result. If 

the currently logged in operator does not have this right, an operator having this 
right can sign immediately. There is no need to change the logged in operator 
previously. 

 
Figure 8-5 Sign Electronic Record dialog 

Operator 
Enter your operator ID. 

Password 
Enter your password. 

Meaning 
Enter the meaning of signing the selected result if desired. 
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Sign 
If operator ID and password meet and if the respective operator has the right to sign 
electronic records the selected result is signed. This is indicated in the Result History 
dialog by a ‘yes’ being entered for the selected result under Signed. Also, additional 
signing information is shown. 
If operator ID and password do not meet or the operator does not have the right to sign 
electronic records a corresponding error message will appear. 
 

8.4 Import Command (Work Table Window) 

The Import command is used to import a sample table into QuantAnalysis in order to 
create a batch file from it. You can import a sample table set up in Agilent ChemStation 
and stored in Comma Separated Values Files format (*.csv) or a sample table set up in 
Bruker Compass HyStar and stored in HyStar Sample Table Extract format (*.seq)  

You can set up a new batch file from a sample table by importing it. Alternatively, you 
open an existing batch file that already contains a sample table and append the 
imported sample table to the present one or replace the present by the imported one.  
Note: If you want to import a sample table into an existing batch file, this batch file 

must still be unprocessed. 
When importing a sample table, that sample data contained in this file that is needed 
by QuantAnalysis is automatically entered in the Work Table of the newly created or 
existing batch file. 
 
If you want to import a sample table into an existing batch file, the respective batch file 
must be opened before selecting the Import command. 
 
Clicking  in the Work Table window opens the Import Sample Table 
dialog, which allows you to specify the name and location of the sample table you wish 
to import. In case of an import into a batch file already containing a sample table, 
define how to proceed with the imported sample table. 

Look in and folder list 
Navigate to the drive and folder that contains the sample table you wish to import. 
Double-click the sample table or select it and click Open. 

File name 
Enter the file name of the sample table or select it from the folder list. 

Files of type 
Select the type of sample table files to be displayed in the folder list: 

Comma Separated Values File (*.csv). Lists Agilent ChemStation sample table 
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files. 
HyStar Tample Table Extract (*.seq). Lists HyStar sample table extract files. 

 

  
Figure 8-6 Import Sample Table dialog  

Append 
Select this option if the sample table to be imported should be appended to a present 
sample table. This setting is only relevant if on importing the sample table a batch file is 
currently open that contains an already imported sample table. In this case, the new 
sample table will be appended. Default setting. 

Replace 
Select this option if the sample table to be imported should replace a present sample 
table. This setting is only relevant if on importing the sample table a batch file is open 
that contains an already imported sample table. In this case, the new sample table will 
replace the current one. 

Open 
If a folder is selected, opens the folder and displays its contents in the folder list.  
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If a sample table file is selected, imports the respective sample table in QuantAnalysis, 
and enters all data files this sample table consists of and corresponding sample data 
already contained in the sample table in the Work Table. The name of the resulting 
batch file depends on how the sample table is imported. If it is imported in an existing 
batch file with Append set, the name of the batch file is not changed. If it is imported 
with Replace set, the batch file gets the name of the imported sample table file with the 
extension being changed to *btc. The same applies to a sample table that is imported 
in a new (untitled) batch file regardless of whether Append or Replace is set. 
 

8.5 Export Command (Work Table Window) 

The Export command is used to export the open batch file to a Comma Separated 
Values Files format (*.csv) e.g. for loading this respective file in Excel. The data actu-
ally exported depends on whether the respective batch file is already processed. 
Processed batches are exported as a results table while unprocessed batches are 
exported as sample table in *.csv file format. 

Clicking  in the Work Table window opens the Export Sample Table dialog 
which allows you to specify the name of the *.csv file to be exported and the target 
folder.  

Save in and folder list 
Navigate to the drive and folder where the exported file should be saved.  

File name 
Enter a new file name or select an existing name from the folder list. 

Save as type 
Select the type of files to be displayed in the folder list: 

Comma Separated Values File (*.csv). Lists files of the Comma Separated Values 
Files format. 

Save 
If a new file name is entered, exports the open batch file to the Comma Separated 
Values File format and saves the resulting *csv file in the chosen target folder.  
If an already existing file name is selected, a confirmation request appears, informing 
you that this file already exists and asks if you really wish to overwrite it. Clicking Yes 
results in the existing file being overwritten, clicking No allows you to enter a new file 
name. 
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Figure 8-7 Export Sample Table dialog 
 

8.6 Select Layout Command (Work Table Window) 

The Select Layout command is used to select a Work Table layout suitable for that 
kind of quantitation you currently want to perform. This can be one of the standard lay-
outs delivered with your system or a layout you created. Loading another layout will 
change the current Work Table layout according to the settings of the new layout. Work 
Table layout files are saved in the QuantAnalysis Layout Files format *.qal. 

Clicking  in the Work Table window opens the Select Work Table Layout 
dialog, which allows you to select a Work Table layout. 
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Figure 8-8 Select Work Table Layout dialog 

Look in and folder list 
Navigate to the drive and folder that contains the layout file you want to select. Double-
click it or select it and click Open. 

File name 
Enter the file name of the layout file or select a layout file from the folder list. 

Files of type 
Select the type of files to be displayed in the folder list: 

QuantAnalysis Layout Files (*.qal). Lists *.qal files. 
All Files (*.*). Lists all data file types. 

Open 
When a folder is selected, opens the folder and displays its contents in the folder list.  
When a layout file is selected, loads the respective layout and changes the current 
Work Table layout according to the settings of the new layout. 
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8.7 Save Layout Command (Work Table Window) 

The Save Layout command is used to save the current the Work Table layout. Work 
Table layout files are saved in the QuantAnalysis Layout File format *.qal. 

Clicking  in the Work Table window opens the Save Work Table Layout 
dialog which allows you to specify the name of the Layout and the folder it should be 
saved in. 
 

  
Figure 8-9 Save Work Table Layout dialog 

Save in and folder list 
Navigate to the drive and folder where the layout file should be saved. 

File name 
Enter a new file name or select an existing name from the folder list. 

Save as type 
Select the type of files to be displayed in the folder list: 

QuantAnalysis Layout Files (*.qal). Lists *.qal files. 
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Save 
If a new file name is entered, saves the current layout in the chosen target folder. If an 
already existing file name is selected, a confirmation request appears, informing you 
that this file already exists and asks if you really wish to overwrite it. Clicking Yes 
results in the existing file being overwritten, clicking No allows you to enter a new file 
name. 
 

8.8 Delete Row(s) Command (Work Table Window) 

The Delete Row(s) command is used to delete a row from the Work Table. This must 
be done in cases such as when you have left a row blank within a batch (because the 
first row that contains no entry in the File Name field is considered to be the end of the 
batch), or if you have entered a sample in a batch file by mistake. Using multiple selec-
tions, you can delete several rows at once.  

Clicking  in the Work Table window removes all entries currently contained 
in the selected row(s) from the Work Table. 
 

8.9 Show Column Command (Work Table Window) 

The Show Column command is used to show a hidden Work Table column. 

Clicking  in the Work Table window opens a drop-down list of all currently 
hidden Work Table columns. Click a column in this list to show the corresponding 
column in the Work Table again. 

  
Figure 8-10 List of currently hidden Work Table columns 
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8.10 Hide Column Command (Work Table Window) 

The Hide Column command is used to hide a Work Table column. Using multiple 
selections, you can hide several columns at once. 

Clicking  in the Work Table window hides the selected Work Table 
column(s). 

Note: Never hide the Sample Type and Calib Level columns. 
 

8.11 Clear Areas Command (Work Table Window) 

The Clear Areas command is used to reset the Work Table of an already processed 
batch file to its state before processing. This allows you to correct a mistake in the 
Work Table after processing has occurred, then reprocess.  

Clicking  in the Work Table window clears all data entered during batch 
processing from the Work Table. This also releases columns that could not be edited 
after batch processing to be available for editing again.  
 

8.12 Plot Column Command (Work Table Window) 

The Plot Column command is used to plot specific quantitation data obtained for a 
batch file’s individual data files by plotting the contents of the corresponding Work 
Table column. This function is restricted to specific columns. 

Clicking  in the Work Table window opens the Plot Column window which 
displays the plot for the selected Work Table column. The plot type can be toggled 
between Bar (default), Line and Area. 
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Figure 8-11 Plot of target compound concentrations calculated for the data files 

investigated with the concentrations displayed as bars 
 

8.13 Show Audit Command (Work Table window) 

The Show Audit command is used to show the audit trail for the open batch file. The 
audit trail lists all changes that were made to this batch file since its setup. 
 
Clicking  in the Work Table window opens the Audit Trail dialog, which 
displays the audit trail for the open batch file.  

The audit trail records each change with its corresponding date and time (Date), name 
of the operator (Who) and what happened (What). It lists all changes that have been 
saved in previous processing of this batch file as well as all current changes already 
made during the running processing of this batch even if the changed state has not 
been saved yet. When the batch file is closed, only those changes that were saved 
during the running processing will be stored in the audit trail.  
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Figure 8-12 Audit trail for a batch file (example) 
 

8.14 Delete Peak Command (Chromatogram/ 
Spectrum Window) 

The Delete Peak command is used to delete a target or ISTD compound peak. Delet-
ing a peak results in the corresponding data being removed from the Work Table and, 
therefore, from being used in quantitation of the open batch file. All corresponding 
quantitation results are immediately updated in the other windows. 

Before selecting this command, you must display the target or ISTD compound peak 
you want to delete in the chromatogram view of the Chromatogram/Spectrum window.  

Clicking  opens the Confirm Delete dialog. If quantitation was 
done with an internal standard you have to select whether the target or the ISTD com-
pound peak is to be deleted by clicking Target Peak or ISTD Peak. If no internal stan-
dard was used ISTD Peak is disabled. On clicking OK, the selected peak is deleted 
and its peak number is removed from the chromatogram view. All corresponding 
entries in the Work Table are also removed. 
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Figure 8-13 Confirm Delete dialog (when an internal standard is used) 

 

8.15 Manual Integration Command (Chromatogram/ 
Spectrum Window) 

The Manual Integration command is used to manually integrate a target or ISTD com-
pound peak which was not recognized during the automatic integration process 
performed on the corresponding chromatogram or which was improperly integrated. 

Manual integration is performed in the chromatogram view of the of Chromatogram/ 
Spectrum window when the Manual Integration mode is active. 

Clicking  in the Chromatogram/Spectrum window activates the 
Manual Integration mode. This can result in the following: 
- In the case of a quantitation with internal standard, the chromatogram trace currently 

not selected in Integrate (Target or ISTD) is hidden from display. If you wish to inte-
grate the currently hidden chromatogram, click the corresponding option to display it 
and hide the other chromatogram. 

- For an already integrated peak, its start and end positions are indicated by two 
handles. 

 
Depending on whether the peak you wish to integrate has already been integrated, 
proceed as follows: 

Integrating an already integrated peak: 
Decide which handle you would like to move, and position the mouse cursor near (3 
pixel) the handle so that it changes to . Then drag the handle with the left mouse 
button held down to the desired position (data point) and release the mouse button. If 
desired, you can change the position of the second handle in the same way. 
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Figure 8-14 Integrating a compound peak manually 

Integrating an unintegrated peak 
Position the mouse cursor, for example to the start of the peak, and click the left mouse 
button to display the two peak handles. Then click and drag these handles to the 
desired positions as described above. 
 
In both cases, the (new) calculated peak area is entered automatically in the corre-
sponding Work Table field and the corresponding quantitation results are immediately 
updated in the other windows. Compound peak areas that were obtained by manual 
integration are colored blue in the Work Table. 
 
Clicking  deactivates the Manual Integration mode. The peak 
handles disappear and a hidden chromatogram trace is redisplayed. 
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